
RELEASE NOTES
Current Release v1.3

v1.3

Version 1.3 contains bug fixes and feature optimisations. There are no changes to the 
document format, so v1.2 documents can be used in v1.3 or vice versa.

GENERAL
• Online activation to get a license key is now working again.
• Application will check for a shared license on the computer. This will allow institutional 

licenses to work for all users on a shared computer. The facility to install the license will 
be achieved by a separate application yet to be released.

• When registering your computer via email, the computer name is now included.
• If a document is locked, the temporary working file will be unlocked.
• Fixed crash when trying to export Rig Data text files.
• Fixed bug where Image Capture does not work on Mac OS X 10.11 El Capitan.
• Photos downloaded from a camera are now stored in a folder with the show document 

name within the CameraDownloads_MLA folder.
• Hog 4 Cue List XML files can now be imported using the File->Import Console Data-

>Hog4 XML file item. Note that the XML currently only contains basic cue information 
(number, name, trigger, trigger time and comment).

• Menu (Import Console Data) Cue List CSV... changed to Cue List Text File...
• Windows OS build in new format and is now dependent upon the Microsoft Windows 

Universal Runtime. The MLA installer will ensure this is installed.
• Fixed crash on Mac OS X that occasionally occurred when exiting full screen mode.
• Fixed bug where show documents with large amounts of console data would not be 

cleared correctly when importing new console data.
• Add dialog when confirming the Production information to allow an email to be prepared 

to send to City Theatrical so that we may keep up to date with which productions MLA is 
being used on.

• Changed behaviour when closing a document or quitting. In the dialog asking if you want 
to Save, Don't Save, Cancel. Clicking on Save will save to the existing file rather than the 
Save As dialog appearing. If a file did not previously exist, the Save As dialog will appear. 

• OSC Setup dialog now allows you to choose TCP as the communication protocol. This is 
the preferred method for the EOS Family of consoles.

• New scripts and enhancements to existing ones.
• New Vx76 XML import that supports large XML files.
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CANON SUPPORTED CAMERAS
Below is a list of Canon DSLR cameras supported according to the current EDSDK driver 
v3.5.

EOS-1D Mark III 
EOS 40D  
EOS-1Ds Mark III 
EOS DIGITAL REBEL Xsi/450D/Kiss X2 
EOS DIGITAL REBEL XS/1000D/ KISS F 
EOS 50D 
EOS 5D Mark II 
EOS Kiss X3/EOS REBEL T1i /EOS 500D 
EOS 7D  
EOS-1D Mark IV 
EOS Kiss X4/EOS REBEL T2i /EOS 550D 
EOS 60D  
EOS Kiss X5/EOS REBEL T3i /EOS 600D 
EOS Kiss X50/EOS REBEL T3 /EOS 1100D 
EOS 5D Mark III 
EOS 1D X 
EOS Kiss X6i/EOS 650D/EOS REBEL T4i  
EOS 6D 
EOS-1D C  
EOS Kiss X7i/EOS 700D /EOS REBEL T5i  
EOS Kiss X7/EOS 100D/EOS REBEL SL1  
EOS 70D  
EOS Kiss X70/EOS 1200D/EOS REBEL T5/EOS Hi  
EOS 7D Mark II 
EOS 5DS / EOS 5DS R / EOS REBEL T6s / EOS 760D / EOS 8000D / EOS REBEL T6i / 
EOS 750D / EOS Kiss X8i  
EOS-1D X Mark II / EOS 80D / EOS Rebel T6 / EOS 1300D / EOS Kiss X80
EOS 5D Mark IV 
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PRESET DOCUMENTATION VIEW
• Fixed bug where it was not possible to edit (draw on) channel photo 4.
• Fixed bug where clearing the focussed flag for only selected presets did not work.
• Unused Channels option in Preset Reconciliation will update channel indication if a 

channel that was previously indicated as unused and is now used.
• Unused Presets option in Preset Reconciliation will now allow presets that were set to 

ignore by the reconciliation to be cleared when the 'Clear Reconciliation state' menu is 
selected.

• Presets that are set to 'ignore' will not be processed for checking of unused channels/
presets, added/deleted channels, updating fixture type or updating preset name.

• The number of presets being displayed and number of channel focuses is now shown 
below the Preset list.

• Fixed bug in Fixture view where after checking a focussed checkbox would cause the 
preset list to scroll to the top.

• Fixed bug where if the photo mode was locked to channel mode and a channel photo 
was deleted it would switch to preset despite the mode being locked.

• Add ability to delete multiple channel photos. When multiple channels are selected and 
deleted, the last photo for each channel will be deleted.

• Added additional window splitters that allow the photo display to be enlarged.
• Added new command 'Split Preset' to the Edit menu. If you have a preset you wish to 

separate say the wash channels and spot channels into their own preset entries, select 
the channels you wish to separate out, then select the 'Split Preset' command from the 
edit menu. This will create a new preset entry which is a copy of the original, but with the 
selected channels moved to the new preset entry.

PRESET DOCUMENTATION FIXTURE VIEW
• Window splitter added so the photo display/preset list can be resized.
• Added channel focus note column to the preset list.
• Focus Notes group box renamed to Preset Notes.
• Removed channel focus from the Preset Notes (previously Focus Notes) group box.
• Removed Zoom button from photo display area.
• View is now scriptable.
• Order By popup menu changed Scenery to Set for consistent use in application.
• Left and Right arrow keys will select the next and previous photos where a channel or 

preset has multiple photos.
• It is now possible to edit the channel's Note and Cue cells in the Preset List.
• Added radio button to allow the cue photo to be displayed. It will use the channels cue. 

Highlight, Hide Others etc. will work on channel photos if a channel ID has been 
assigned the the drawing elements.

• The cue number shown in the Preset Notes section is now the presets cue, not the 
displayed channels.

PRESET PHOTO ZOOM WINDOW
• Dialog has been changed to a window so it can remain open and no longer modal.
• Window is now resizable.
• Added window splitter between the photo and channel list so it may be resized.
• Channel list now has the focus Note column.
• When the window is open, it will follow preset selection in the Preset Documentation 

view. It will not follow channel selection while open.
• When the window is closed, it will no longer copy the previous channel selection in the 

window back to the Preset Documentation view.
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• Fixed issue in the Photo Zoom window where it was not possible to click the next button 
to see the additional photos for the preset/channel.

• In the Photo Zoom window, the keyboard left and right arrow keys can be used to step 
through the additional photos for a preset/channel.

CUE LIST VIEW
• A new toolbar button has been added to hide or show cue parts in the displayed cue list.
• A new toolbar button has been added to hide to show annotations (drawings) on the cue 

photos.
• Window Splitters added to resize cue info/photo area.
• The image in the Follow Console toolbar button has been changed as it is no longer 

specific to MSC triggers. EOS can use OSC as a trigger.

CUE PHOTO ZOOM WINDOW
• It is now possible to drag the cue HUD display by click dragging the top bar of the HUD. 
If the HUD is not dragged, it's behaviour is as before and will adjust its position when the 
window is resized. Note this it is not possible to drag the HUD out of the photo area.

RIG DATA VIEW
• Added PS & OP (Prompt Side & Opposite Prompt) choices when editing the Orientation 

column. 
• Fixed bug where changing the fixture type of a fixture did not add the fixture profile into 

the show document.
• Filter popup menu now includes columns User 1 to User 6.
• Fixed bug that would cause out of range DMX addresses when adding fixtures and 

specifying a negative offset.
• Changed edit behaviour for offsetting values. Use ++ or -- instead of single + or -, i.e 

++10 Will increment selected cells by 10
--5 Will decrement selected cells by 5
This is to fix issue when using negative numbers in the X, Y & Z location cells.

WHEEL LOAD VIEW
• When a wheel image is dragged and dropped out of the application (i.e. to the desktop), 

the file name will now include a '.jpg' file ending.

CHANNEL USAGE VIEW
• Fixed bug introduced in grandMA2 v3.1.2.5 imports that would not show correct preset 

usage for global presets.
• Added Show Only Unused option for processing to only show channels that have no 

intensity greater than zero.
• Fixed bug where specifying a cue range was not correct if the To or From cue did not 

exist in the cue list.
• Fixed issue where if a single channel is specified as the From channel with no To 

channel specified, it did not work as expected.

PRESET DATA VIEW
• Added window splitter to allow the preset list and channel list to be resized horizontally.
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EOS CSV IMPORT
• The reporting of ‘Unexpected LEVEL_REFERENCE_TYPE’ to the import log has been 

removed. It was discovered that some shows with a lot of colour palettes would take a 
very long time to import when reporting this message.

• The import progress dialog progress bar will now show the progress of the data import 
correctly.

• The time taken to complete the import is now added to the import log.
• Fixed issue where import would be missing data if there were no cues in the csv file.
• Number of target entries are now logged to the log window.

grandMA2 XML IMPORT
• Optimisations have been made to the XML import to reduce the time taken to complete 

the import.
• The time taken to complete the import is now added to the import log.
• In the import dialog a label has been added... "Typically you need to choose the 'gma2' 

folder." due to users experiencing issues when they choose the incorrect folder.Vx76 
XML IMPORT

• Optimisations have been made to the XML import to reduce the time taken to complete 
the import.

• The import progress dialog progress bar will now show the progress of a Stack import.
• The time taken to complete the import is now added to the import log.
• Fixed bug on Windows OS when an imported sequence already exists in the show 

document. Multiple dialogs asking how to proceed would appear (and ultimately ending 
in a crash).

Vx76 XML IMPORT
The XML importer for the PRG Vx76 console has been rewritten to support large (multi 
gigabyte) XML files. The import options dialog now has options to allow you to choose 
which cue data Stacks to import. It is worth noting that while the XML will load, very large 
files may still run out of memory if many stacks with thousands of cues are imported. The 
importer used in prior MLA versions can still be used by holding the Option key on the 
keyboard when choosing the File->Import Console Data->Vx76 XML... menu item.

OSC using TCP
OSC communication can be work with either UDP or TCP data packets (depending on the 
device you are communicating with). TCP is a more reliable method of sending and 
receiving OSC data. The recommended method for ETC EOS range of consoles for OSC 
communication is TCP.

OSC Setup Dialog
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The Protocol popup menu allows you to choose between TCP and UDP. If the Protocol 
popup menu is set to TCP, and the Console Type popup menu is set to ETC EOS Family, 
the Console Port will be set automatically to the one the consoles uses for TCP 
communication.
On the ETC EOS Family of consoles, as of software version 2.4, the Show Control setup 
for OSC looks like below...

EOS Console Show Control Settings

You need to ensure the OSC TX IP Address is the IP address of the computer running 
MLA. The OSC TX and RX Port Numbers are only applicable if you are using  the UDP 
protocol. String and OSC TX should be enabled. I believe String RX should also be 
enabled.  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EXPORTING PATCH FOR ETC EOS FAMILY CONSOLE
The rig data text file export has a few added control to make it easier to export the patch 
as a text file that can be imported using the EOS Lightwright import feature.

Text File Export Dialog

Before you attempt an export, you should set the DMX Format preferences to be Numbers 
(i.e. 2/23, not B/23).
To export for the EOS console, you need to have the following options set...
• Click the EOS button to set the data fields to export.
• Check the 'Include Field names as first record.' checkbox.
• Check the 'Tab delimiter' checkbox.
• Ensure the 'Window OS' Line Endings radio button is checked.
• When you click OK to save the file, ensure the file ending is .txt and not .csv.

The file can then be imported into the EOS console. Refer to the ETC EOS release notes 
for software version 2.3 on how to do this. You will need to map the fields exported to the 
EOS fields. Generally you only need to do Channel, Address, Type and Fixture Type.
 

PHOTO EXPORT
• When exporting photos with drawings, they are no longer scaled. The photo (and 

drawing) will be exported at the resolution they are in the show document.
• All files are now appended with a '.jpg' file extension.
• All 4 channel photos are now listed for exporting.
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CAMERA CONTROL - DIRECT SHOW
Improvements have been made when using DirectShow (only applicable on Windows OS). 
In the 'Settings' dialog (click on the 'Settings' button in the Direct Show Live Preview 
window) there is now a Video Format popup menu to chose the input devices video 
format. When using a video input card such as the DeckLink Mini Recorder the video 
format must be set to match the incoming video signal for the video to be displayed. You 
can try different formats until an image is displayed.

Vx76 CONSOLE DIALOG
It is now possible to send text data to the Vx76 patch Location, Tags and Notes fields. This 
will only work correctly on Vx76 software version 4.2.1 onwards. In the MLA Vx76 dialog, 
check the fields you wish to set and then choose from the popup menu the MLA column to 
get the text from. Current choices are Position, Purpose, Label and User columns 1 to 6.
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IMPORTING TIMECODE LIST FROM INQSCRIBE AND REAPER
It is now possible to import timecode list exported from InqScribe or Reaper applications. 

Exporting from InqScribe.
This works best where the timecode list is simply the timecode marker and a description 
(referred to as a transcript in InqScribe) as shown below.

Example InqScribe Timecode List

MLA can assign cue numbers to each entry when the list is imported into MLA.

It is also possible to use timecode lists where the cue number is included in the transcript. 
There should be a prefix character before the cue number such as 'Q'. Below is an 
example...

Example InqScribe Timecode List with Cue Numbers

You can use a different prefix character to the cue number, but you will have to specify the 
character when you import the list into MLA.
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To export the timecode list from InqScribe.. 
• Choose the menu File->Export->Tab-delimited Text...
• Format should be Tab-delimited Text.
• In the dialog that appears (Shown below), ensure Export Out Points is not checked.
• Enter a name for the export file in the Target field and Choose where you want is saved.
• Click Export button.

Export Settings dialog

You should now have a file that is ready for importing into MLA.
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Importing InqScribe Text File Into MLA
You can import into a new show document or one with existing data. As long as the 
imported Sequence/Cue List ID is unique, it will appear as it's own cue list. If the imported 
Sequence/Cue List ID is the same as one that already exists in the show document, it will 
be merged and may result in duplicate cue numbers.

To import the text file exported from InqScribe (described earlier), choose the menu 
File->Import Console Data->Cue List Text File...
A dialog will open as shown below.

Cue List Text File Import Dialog

You will need to set the following options...
• Ignore First Record (This means the field headers IN & TRANSCRIPT will not be imported).
• Tab delimiter (The data field in the file exported by InqScribe are tab separated).

You will need to enter a name for the cue list. Depending on the console this may need to 
be a number.

The Split Vx76 Stacks option is not relevant for this import.

If you have included the cue number in the transcript i.e. Q12 Whoosh, then check the 
InqScribe Transcript Contains Cue Number checkbox. You can then change the Cue 
Number Prefix as needed. The default is 'Q'.

If you want MLA to number your cues when it imports the file, you can check the Generate 
Cue Number checkbox and then enter a start cue. The Increment field is by how much 
each cue is incremented by.

Click the InqScribe button and it will match the applicable database fields within MLA to 
the import fields. You can of course choose to use different fields, although currently the 
InqScribe Transcript Contains Cue Number option will only work with the 'Name' field.

Click the Import button to complete the import. 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Exporting from Reaper.
You can export the Markers as a CSV file. You should ensure your ruler setting is set to 
Hours:Minutes:Seconds:Frames (Menu View->Time unit for ruler), otherwise the times 
values exported will be in another format i.e. measures and beats.

You can see your Marker list with the menu View->Region/Marker Manager.

Region/Marker Manager Window

You will need to be able to trigger the Action "Markers/Regions: Export markers/regions to 
file". You may already have this Action set up to a menu or shortcut. If you don't, go to the 
menu Actions->Show action list... . 

Actions Window

In the Filter type 'Marker' and it the action list will show all the actions with the word 
Marker. Scroll until you find 'Markers/Regions: Export markers/regions to file'. Click to 
select it and then click the run button. You will be prompted where to save the file.

You should now have a file that is ready to be imported into MLA.
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Importing Reaper Text File Into MLA
You can import into a new show document or one with existing data. As long as the 
imported Sequence/Cue List ID is unique, it will appear as it's own cue list. If the imported 
Sequence/Cue List ID is the same as one that already exists in the show document, it will 
be merged and may result in duplicate cue numbers.

To import the text file exported from Reaper (described earlier), choose the menu 
File->Import Console Data->Cue List Text File...
A dialog will open as shown below.

Cue List Text File Import Dialog

You will need to set the following options...
• Ignore First Record (This means the field headers IN & TRANSCRIPT will not be imported).
The default Field Separator of a comma is correct. Tab delimiter should be unchecked. 

You will need to enter a name for the cue list. Depending on the console this may need to 
be a number.

The Split Vx76 Stacks option is not relevant for this import.

InqScribe Transcript Contains Cue Number checkbox should be unchecked as it is not 
applicable to this import

If you want MLA to number your cues when it imports the file, you can check the Generate 
Cue Number checkbox and then enter a start cue. The Increment field is by how much 
each cue is incremented by.

Click the Reaper button and it will match the applicable database fields within MLA to the 
import fields. You can of course choose to use different fields. Although the Reaper '#' field 
contains an M (for marker), it will be removed when turned into a cue number.

Click the Import button to complete the import. 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Importing Sequence and Timecode files into the grandMA2
Once you have the 2 XML files, one for the sequence, and one for the timecode, you 
should place them onto a USB stick. They must be in the importexport folder within the 
gma2 folder. Once you have inserted the USB stick into the console (or onPC), you need 
to select the USB disk in the Backup window. You now need to type some commands on 
the command line to import the files.

First you need to navigate to the sequence pool. Type the following pressing return after 
each line...

cd sequences 
cd global

Now to import your sequence file, type...
import NAME_OF_FILE at SEQUENCE_NUMBER
where...
NAME_OF_FILE is the name of the sequence XML file you wish to import.
SEQUENCE_NUMBER is the sequence number you wish to import the sequence to. 
Typically this would be the sequence number you specified when you ran the script to 
export the xml file.

The file should now be imported. You will see the results of the import posted in the 
command line window. You will probably want to assign the sequence to an executor.

To import the timecode XML file, you first need to back up the directory structure, so type...
cd..
cd..

Now type...
cd timecode
import NAME_OF_FILE at TIMECODE_NUMBER
where...
NAME_OF_FILE is the name of the timecode XML file you wish to import.
TIMECODE_NUMBER is the timecode number you wish to import the timecode list to.

You may need to 'Change Executor/Fader' in the 'Track Functions' window of the timecode 
list to the executor the sequence is assigned to.
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REPORTS

CHANNEL DATA REPORT
A new report for reporting the cue data for a channel. You will be prompted for which 
cuelist/sequence and which channel you want in the report. The report will only show the 
first 15 parameters of data. It can show more, but the report would have to be edited.

PRESET DOCUMENTATION REPORT
• Fixed bug where the channels listed for a particular preset photo was listing all channels.
• Fixed bug where not all channel photos were displayed if there was more than 1 for a 

channel.
• Added PresetImage1, PresetImage2, PresetImage3, PresetImage4.
• Added ChannelImage1, ChannelImage2, ChannelImage3, ChannelImage4.
• It is now possible to generate a report on a specific range of presets. A dialog now 

appears when a Preset Documentation report is chosen to select either all presets or a 
specified range.

WHEEL LOAD REPORT
• Fixed bug where Effect Wheel 3 would not always show wheel graphic.
• Added ChannelList field which will contain a list of the channels using the wheel load.
• Added ChannelCount field which will be the number of channels using the wheel load.
• Added FixtureList field which will contain a list of the fixtures using the wheel load.
• Added FixtureCount field which will be the number of fixtures using the wheel load.

GENERIC REPORT
• Added preset priority text handling.
• Added PresetDoc_Channel_List & PresetDoc_Fixture_List fields.

SCROLLER MOVES REPORT
• Fixed bug where it could in some instances get stuck in a loop.
• Added support for Hue/Saturation based fixtures such as the ETC Source 4 Lustr+.

CHANNEL USAGE REPORT
• Added UsageSceneName field.
• Added fields to access preset usage

AllPresetCount
PositionPresetCount
ColourPresetCount
GoboPresetCount
AllPresetName
PositionPresetName
ColourPresetName
GoboPresetName

See the ChannelUsage_Presets.lhf template as an example as this will list all the 'All' and 
'Position' presets (current layout is for EOS, so Presets and Focus Palettes) recorded in 
the cue lists specified in the Channel Usage view.
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CUE LIST REPORT
• In the options dialog when building a cue list report, it is now possible to specify a start 

page number. This will only work with the report.page_number place holder. This is 
useful when having to combine the pdf documents of several cue list reports of a cue list 
into one pdf document.

• There is a new report, CueList_Image which will do a cue photo per page. Useful if you 
need to send someone a document of cue photos from the production.
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SCRIPTING
• New functions PresetDocView:IsLastPresetRowSelected and 

PresetDocView:IsLastChannelRowSelected.
• New function RigDataView:IsLastFixtureRowSelected.
• New function CueListView:IsLastCueRowSelected.
• PresetInfo has new property PriorityName to get the user defined name for the priority.
• New Dispatch Actions for PresetDocView:DispatchAction("Sort By", "Preset ID"), 

PresetDoc:ViewDispatchAction("Filter By", "Preset ID"), 
PresetDoc:ViewDispatchAction("Filter Text", "Courtyard")

• New function PromptChoiceDialog to allow a customisable dialog to be presented to the 
user to allow the them to choose between 2 choices.  Useful to present a dialog for the 
user to decide if the script should continue i.e. Is the taken photo acceptable ?

• New function FormatTimecode.
• New functions FomattedTimeToMilliseconds and FormattedTimeToSeconds.
• New functions SendAppleEvent and SendVx76AppleEvent.
• New function TimecodeToMA2TCTime.
• New function PromptPopupMenuDialog.
• Added FileType popup menu in output window to set file type when saving.
• Added OutputFileType comment macro.

Specific details about the new functions are on the MLA Wiki page...

http://www.wiki.movinglightassistant.com/wiki/

SCRIPT CHANGES
EOS Preset Auto Photo

Added a variable delayPrePhoto which is how long the script will wait for the lights 
to get into position before the photo is taken. The default is 2 seconds (was previously 1 
second in v1.2).  Adjust as required if you have lights that take a while to move into 
position.

The delay after a photo is taken is now longer to allow for the Preset Documentation 
view to update showing the taken photograph.

A new variable have been added. recallFromCue. When the recallFromCue is set to 
true (it is by default), channels will be recalled from their focus cue prior to the photo being 
taken.

MA2 Preset Auto Photo
Added a variable delayPrePhoto which is how long the script will wait for the lights 

to get into position before the photo is taken. The default is 2 seconds (was previously 1 
second in v1.2).  Adjust as required if you have lights that take a while to move into 
position.

The delay after a photo is taken is now longer to allow for the Preset Documentation 
view to update showing the taken photograph.

Two new variables have been added. recallFromCue and whitePreset. When the 
recallFromCue is set to true (it is by default), channels will be recalled from their focus cue 
prior to the photo being taken. When this option is set, the whitePreset variable should be 
set to the preset identifier of your white colour preset so the lights are set to white before 
the photos are taken.
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EOS Build Focus Cuelist
This script can be used to build a cue list on the console containing presets in the 

preset documentation list. This is useful for having a cue list to step through to focus a 
show i.e. on a tour. See the Scripts v1.2.1 document for details.

MA2 Build Focus Cuelist
This script can be used to build a cue list on the console containing presets in the 

preset documentation list. This is useful for having a cue list to step through to focus a 
show i.e. on a tour. See the Scripts v1.2.1 document for details.

HOG4 Export Cuelist XML
This script is used to generate a cue list XML file that can imported in the Hog 4 

console. It will build the list from the currently displayed cue list shown in MLA. It will 
include timecode times. A timecode cue list can be imported from InqScribe or Reaper and 
then exported to the Hog 4. See the Scripts v1.2.1 document for details.

Vx76 Export Timecode CSV
This script is used to generate a CSV file that can imported in the Vx76 console. It 

will build the list from the currently displayed cue list shown in MLA. It will include timecode 
times. A timecode cue list can be imported from InqScribe or Reaper and then exported to 
the Vx76. See the Scripts v1.2.1 document for details. Vx76 Console software version 4.3 
onwards supports importing of Timecode scripts.

OTHER FIXES
• 'CueList EOS 1 Image' Report. Fixed focus, colour and beam times to be displayed in 

correct place on page.
• Corrected release notes that stated an added preset/channel while reconciling would be 

indicated in blue, when it should have said green.

FIXTURE PROFILE UPDATES
Martin
MAC Viper Profile - Corrected DMX Profile channel counts.

Clay Paky
Alpha Profile 700 - Added colour part numbers.
Alpha Wash 700 - Added colour part numbers.

Many additions.
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v1.2

Version 1.2 includes new features and bug fixes. There have been a lot of internal 
changes as the development system used to build MLA has moved from RealStudio to 
Xojo. The Mac OSX version of the application is now built against Apple’s Cocoa 
framework as opposed to previously the Carbon framework.

New features and improvements include...

Improvements to Preset Documentation view...
Support for up to 4 channel photos.
Ability to list only used presets in Add Preset dialog.
Ability to add only the used channels by a preset in the Add Preset dialog.
Ability to assign a priority to a Preset.
Reconciliation with Console Data.
Improved sorting and filtering.

Improvements to Rig Data view…
Added ability to increment, decrement and offset values in some columns.
Added ability to count items in the Rig Data view.

Application Scripting support.
Communication with grandMA 2 console over a network connection using Telnet.
Communication with the ETC EOS Family of consoles over a network connection.
Communication with consoles using OSC (Open Sound Control).
PRG’s Vx76 Console XML Import.
Ability to import data from another MLA show document.

Version 1.2 documents are in a new format, so existing show documents will be 
updated when used in this version. Version 1.2 documents may well open and 
appear fine in prior versions, but they should not be edited then saved.

IMPORTANT !
In this version on Mac OSX, Quicktime is no longer an option in the Camera Setup dialog 
and has been replaced by a few framework, AV Foundation.

GENERAL CHANGES
• The application can now support up to 100 parameters of imported Cue and Preset 
console data.
• Document Preferences has been updated to include a Preset Documentation tab. More 

details are in the notes below about Preset Priorities.
• Document Preferences Intensity rounding preference is now taken notice of in console 

data cue views.
• Document Preferences has a new preference Lowest On Intensity which is not currently 

implemented.
• The Manage Positions dialog on Mac OSX no longer uses a drawer to display the 

additional trims. The dialog now expands to show the additional trims. 
• Fixed issue where the Import Log was not saved into the show document.
• Beta versions will display a dialog warning when there are less than seven days to it 

expiring.
• Registration dialog will now show if a serial number is too long or too short. 
• The status bar along the bottom of the document will show if you are connected to an 

EOS or grandMA2 console.
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• The 'CameraDownloads' folder will now be created in the users 'Pictures' folder as 
'CameraDownloads_MLA' instead of within the MLA application folder. Remember, these 
images are only used to transfer the image into the show document, and after the photo 
is taken and it appears in MLA, the files are no longer required, but my be useful as a 
backup.

• Added ability to test a test photo. When you are connected to a camera, if you click on 
the camera status area of the status bar at the bottom of the document window, a menu 
will pop up to enable you to take test photo. It will take a test photo and display the photo 
preview window (regardless of the preview setting in the Camera setup dialog). The test 
photo will not be assigned to any cues or preset photos.

• Camera preview window is now resizable and can be maximised.
• Using latest Canon camera driver, v2.15.

Canon Supported Cameras...

EOS-1D Mark III 
EOS 40D  
EOS-1Ds Mark III 
EOS DIGITAL REBEL Xsi/450D/ Kiss X2 EOS DIGITAL REBEL XS/ 1000D/ KISS F EOS 50D 
EOS 5D Mark II
EOS Kiss X3/EOS REBEL T1i /EOS 500D  
EOS 7D  
EOS-1D Mark IV 
EOS Kiss X4/EOS REBEL T2i /EOS 550D  
EOS 60D  
EOS Kiss X5/EOS REBEL T3i /EOS 600D  
EOS Kiss X50/EOS REBEL T3 /EOS 1100D  
EOS 5D Mark III 
EOS 1D X 
EOS Kiss X6i/EOS 650D/EOS REBEL T4i  
EOS M 
EOS 6D  
EOS-1D C  
EOS Kiss X7i/EOS 700D /EOS REBEL T5i  
EOS Kiss X7/EOS 100D/EOS REBEL SL1  
EOS 70D  
EOS Kiss X70/EOS 1200D/EOS REBEL T5/EOS Hi 
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PRESET DOCUMENTATION VIEW

Preset Priorities
It is now possible to assign a priority to a preset. Assigning a priority to a preset is a useful 
way to indicate which presets are the most important to get re-focused or looked at.

There are six priority levels with 1 being the lowest and 6 being the highest. You can set 
the name for a priority level in the document Preferences dialog (under the Preset 
Documentation tab). You may wish to customise the names to suit your own workflow. 
Each priority level can also be assigned a background colour. Click on the ‘Colour’ button 
next the text field for a priority to set the colour.

It is possible to sort and filter the preset list by priority. When you sort by another data field 
i.e. by Set, the sorted Set list will also be sorted by priority (the highest being first).

When presets are added to the Preset Documentation list, its priority will be set to the 
default priority as configured in the document Preferences dialog.

To change the priority of a preset (or a selection of presets), Click on the little up/down 
arrows in the Priority cell for a Preset in the Preset List. A menu will appear for you to 
choose the priority you wish to set.

Reconcile With Console Data
A new button in the Preset Documentation button bar allows for easier reconciliation 
between the console preset data and the preset documentation data. If you are importing 
console data after you have added Preset Documentation data, it is easier to use 
Reconcile with Console Data to update presets and channels in the Preset Documentation 
view. The left side of the dialog is for added and deleted Presets. The right side of the 
dialog is for modifying existing Presets in the Preset Documentation Preset List.

When the reconciliation has been completed, a window will open with a log of what was 
changed. It is possible to save the output of the log as a text file.

Reconcile with Console Data Dialog  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Added Presets
When you have imported console data overwriting previous console data, and you want to 
automatically add presets you can use the options described below. If you are adding 
Presets, you will need to select the Preset Type from the popup menu. Any presets or 
channels added will be in green text.

Do Nothing
When selected, no Presets will be added to Preset Documentation.

Add New Presets
With this selected, only presets that were new in the latest import will be added. This 
is generally the best option to use when you have overwritten existing console data 
with an import. It will not add presets that previously existed in the console data.

Add Undocumented Presets
With this selected, any presets that are in the console data and not in Preset 
Documentation will be added.

Only Add Used Presets
With this option checked, when using either Add New or Add Undocumented, only 
Presets that are used in a cue list with an intensity greater than 0% will be added to 
Preset Documentation. If a Preset is only used in the Rig Check, it will not be added.

Only Add Used Channels
With this option checked, when using either Add New or Add Undocumented, only 
channels that are actually used in a preset (intensity greater than 0%) will be added. 
If a channel is only used in the Rig Check in a Preset, it will not be added.

Deleted Presets
If the console data has been overwritten and a Preset no longer exists, you can decide 
how this should be reconciled with the Preset Documentation data.

Do Nothing
When selected, no Preset Documentation data will be modified.

Indicate Presets
If a Preset does not exist in the latest console data import, it is considered deleted. It 
can be indicated in the Preset Documentation Preset list if it existed there. The text 
for the Preset in the Preset list will be in red. This is handy to allow you to decide 
what you would like to do at a later date.

Delete Presets
If a Preset does not exist in the latest console data import, it is considered deleted. 
With this choice selected, the Preset will be deleted from the Preset List in Preset 
Documentation.
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Modifying Existing Presets
All Presets/Selected Presets
If All Presets is selected, then the options below will affect all the Presets in the Preset List. 
If Selected Presets is selected, then only the selected Presets will be affected.

Added Channels
If channels exist in the console data, but not in the Preset Documentation data for a 
Preset, then they can be added automatically. Any added channels will be indicated in 
green text.

Do Nothing
With this selected, no channels will be added to existing Presets (All or Selected).

Add Channels
With this selected, any channels not in a Preset Documentation Preset that do exist 
in the console data will be added.

Add Only Used Channels
When using the Add Channels option, only channels that are used in a cue list with 
an intensity greater than 0% (and not in the Rig Check) will be added to a Preset 
when this checkbox is checked.

Deleted Channels
If a channel exists in a Preset in the Preset Documentation data, but is no longer in the 
imported console data, then it could be considered deleted. Below are the choices as how 
to handle the channel.

Do Nothing
With this selected, no action will be taken on deleted channels.

Indicate Channels
If a Channel for a Preset does not exist in the latest console data import, it is 
considered deleted. It can be indicated in the Preset Documentation Channel list if it 
existed there. The text for the Channel in the Preset list will be in red. This is handy to 
allow you to decide what you would like to do at a later date.

Delete Channels
If a Channel in a Preset does not exist in the latest console data import, it is 
considered deleted. With this choice selected, the Channel will be deleted from the 
relevant Preset in Preset Documentation.

24th January 2017



Unused Presets
Checking for unused Presets will look at existing Presets in the Preset Documentation and 
see if they are used in a cue list.

Do Nothing
When selected, no action will be taken on unused Presets.

Set to Ignore
Any Presets found not to be used will be have their Ignore option set (they will 
appear grey in the Preset List). You can then decide a a later time if you wish to 
manually delete the Preset.

Unused Channels
Checking for unused Channels will look at the channels in existing Presets and see if they 
are used in the cue lists.

Do Nothing
When selected, no action will be taken on unused Channels.

Indicate Channels
Any Channels found not to be used will grey in the Channel List. 
You can then decide a a later time if you wish to manually delete the Channel.

Update Fixture Types
When this checkbox is checked, the fixture type for each channel will be updated to the 
fixture type in the current console data patch.

Update Preset Names
When this checkbox is checked, the preset name in the console data will be compared to 
the preset name in the Preset Documentation. If it is different, the preset name in the 
Preset Documentation will be updated to the name in the console data. The comparison is 
made by the preset number, so if you have moved presets on the console you may get 
incorrect names for your presets in Preset Documentation.

Clearing Reconciliation State
If you wish to clear the reconciliation indications for Presets and Channels, you can do so 
with the ‘Clear Reconciliation Sate’ menu in the ‘Edit’ menu.
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Preset Sorting and Filtering
There have been some improvements to the sorting and filtering of the presets in the 
Preset List.

Custom Ordering
It is now possible to order the presets into the order you prefer. From the Sort popup 
menu, select the ‘Custom’ option. A dialog will open to allow you to re-order the presets.

Manual Preset Re-Order Dialog
Simply click to select a row and drag to the position in the list you wish to place the preset. 
You will see a black bar indicating where the row to be moved to while click dragging. It is 
possible to select multiple rows (shift clicking) and then dragging them to the new position.

The Sort By: popup menu allows you to re-order the presets in the dialog. Current Sort is 
the order the presets are currently ordered by in the Preset Documentation view.

Clicking the OK button will re-order the Preset list in the Preset Documentation view as per 
the order in the dialog. Clicking the Cancel button will not change the Preset List order.

User Sorts
It is possible to save the current order of the Preset list as a user sort. There are two 
additional buttons in the sort and filter control area below the Preset List.

Sort & Filter Controls
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The ‘+’ and ‘-‘ buttons are for adding and removing user sorts. Once you have the Preset 
List ordered how you want it, click the ‘+’ button.

Add User Sort Dialog

A dialog will open to enable you to name the user sort. Each user sort name must be 
unique. If you use the same name as a user sort that already exists, you will be prompted 
if you want to over write the existing user sort. The ‘Include Filter’ checkbox will save the 
current filter applied along with the Preset List order.

Once the user sort has been added, it is available for you to choose from the Sort popup 
menu. User sorts are stored in the show document.

Deleting a User Sort
To delete a user sort, select it from the Sort popup menu. The ‘-‘ button will be enabled. 
Click the ‘-‘ button and a dialog will appear asking to confirm you wish to delete the user 
sort.

Filtering
When a filter is applied to the Preset list, the lists background colour will change to a pale 
red colour to indicate it is filtered.

Other Changes
• Add Presets dialog now has a checkbox ‘Only List Used Presets’. This checkbox will only 

be enabled when the tracked cue data has finished loading. When the checkbox is 
checked, the preset list will only be populated with presets that are used in the show 
where the intensity is greater than zero percent. This checkbox can be used in 
combination with the checkbox ‘Only List Undocumented Presets’. When the checkbox is 
clicked on, it may take a few moments for the preset list to update as depending on the 
show size, there will be a lot of data to search. Groups are not affected by this option.

• Add Presets dialog now has ‘Add only used Channels’ checkbox which will only be 
enabled when the tracked cue data has finished loading. When checked, it will only add 
the channels to the preset when they are recorded in a cue list/sequence with an 
intensity greater than zero percent.

• A channel can now have up to 4 channel photos. It is possible to add or copy an image to 
one or more selected channels, though it should be noted that if a channel already has 4 
channel photos, then the add or copy will silently fail for that channel. 

• Because of the support for multiple channel photos, it is longer possible to delete a photo 
for more than 1 selected channel.

• Channel ‘Image’ column will now show how many channel photos are stored for a 
channel.

• If you try to set the first used cue and have not defined the main cue list, a dialog will now 
pop up to inform you that the main cue list has not been set.

• Preset Photos no longer have a border drawn around them in the actual photo. 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PRG Vx76 CONSOLE XML IMPORT
In this version it is possible to import the XML files generated by PRG’s Vx76 Consoles. 
Currently Vx76 software version 4.1 has the XML export feature that is compatible with 
MLA v1.2. Prior to Vx76 software version 4.1 there is no XML export feature. Vx76 
software version 4.1 beta versions prior to B23 are likely to causes errors.

Exporting from the Vx76 Console
To export the XML data for the current show file, choose the ‘Export XML…’ from the ‘File’ 
menu of the Vx76 application. A dialog will open where you need to name and decide 
where to save the XML file. The progress of the export will be displayed on the centre 
screen of the main face panel (or Panel Server if you are running the software not 
connected to a face panel). Note that large shows can take quite a while to perform the 
XML export.

Importing the Vx76 XML file into Moving Light Assistant
To import the Vx76 console data into MLA, you may wish to start with a new show file. 
From the ‘File’ menu, choose ‘Import Console Data’ -> ‘Vx76 XML…’. You will be prompted 
to choose the file to open. Open the file you recently exported from the console software.
Once the file is chosen, a dialog will appear allowing you to select which data types you 
wish to import.

Vx76 XML Import Dialog

If there is already console data in the show file, you will be prompted if you want to Merge, 
Replace or Cancel. 

Merge - Merge will delete the existing data of the same type being imported. For example, 
if your show file contained Patch, Presets and Cue Data from a previous import, if you try 
to import preset data on a subsequent import, the existing preset data would be deleted 
before the new preset data is imported. The patch and cue data would be unaffected.
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Replace - Replace will delete all the existing console data in the show file and import the 
XML file.

Cancel - Will exit and not delete or import and data.

A progress dialog will appear showing the progress of the XML import. For large shows 
this may take a while. Once the import is complete, check the Import Log for any errors. It 
should now be possible to use MLA to analyse and work with the data in the same way 
you can with other supported consoles.

There may be issues importing extremely large xml files that may cause MLA to crash 
while importing. This will hopefully be addressed in a later release.

Note that because there is not a standard naming for parameters across fixture types, the 
intensity parameter will be renamed within MLA as ‘Inten’.
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SCRIPTING
Scripting allows the automation of the applications user interface, communication to 
consoles (EOS & grandMA2) and also access to the data in the show document.

Details about the language and functions can be found at…
http://www.wiki.movinglightassistant.com/wiki/

Scripts are text files and are located in the ‘Scripts’ folder within the MLA folder. You can 
create and edit scripts in a text editor or by using the built in script editor. The advantage of 
the built in script editor is that you can run the script easily from the editor without having to 
save and re-load the script. 

When a script is running, a little icon will flash in the status bar along the bottom of the 
document window. You can stop a running script by clicking on the flashing icon in the 
status bar. You can stop a specific script, or all running scripts.

The is a separate document explaining what the scripts supplied will do.

Managing Scripts

Manage Scripts Dialog

The Manage Scripts Dialog allows you to configure how a script is run. The table columns 
are as follows…

Name
The names is the name of the script. This is determined by the file name of the script text 
file.
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Trigger Type
A script can be triggered several ways. In this column you can choose how a script is 
triggered. Currently only Menu, Key, EOS Macro and grandMA2 Macro trigger types work. 

Trigger types..

Menu - The script name will appear in the ‘Scripts’ menu and by choosing the menu item 
will trigger the script to be run. 

Key - A script assigned to a key will be triggered when a keyboard key is pressed. This will 
only happen when you are not entering text into a field or table. When the trigger type is 
set to key, the ‘Trigger Capture’ button will be enabled. This allows you to capture which 
key you wish to use as the trigger.

EOS Macro - A script can be triggered when a macro is run on an EOS Family console. 
The trigger value will be the macro number. This will only work when you are connected to 
the console via a network connection that is configured to use the OSC protocol.

grandMA2 Macro - A script can be triggered when a macro is run on an grandMA2  
console. The trigger value will be the macro number. This will only work when you are 
connected to the console via a network connection that is configured and connected.

Trigger Value
This column will show the value specific to the trigger type. When the Trigger Type is EOS 
Macro or grandMA2 Macro, you can double click the cell to edit to enter a macro number.

Output Window
For some scripts you will want a window to send output text to so that you can save it later. 
If you want an output window then you just need to check the enable check box.

Location
This column displays where the script is located. Currently they will only be in the scripts 
folders, but shortly they will be able to be located in the show file if required.

Reloading Scripts
Scripts are loaded when the application is launched. If you add or edit scripts you can 
choose ‘Re-Load Scripts’ from the Scripts menu to re-load and re-build the Scripts menu 
and the scripts that appear in the Manage Scripts dialog. If you edit a script that is in the 
scripts folder, once you have finished and saved the script, reload the scripts otherwise 
when you run the script it will run the old version.
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OSC (Open Sound Control) 
OSC can be used to communicate with consoles over a network connection. Interaction 
with a console is primarily handled through scripting. There are specific OSC functions for 
sending commands to a console. For the ETC EOS Family of consoles, there is also some 
integration with the handling of data sent from the console. 

OSC will only work on ETC EOS Family of consoles with software v2.3 onwards.

MLA Configuring and Setup
To setup an OSC network connection, choose from the ‘Setup’ menu, ‘OSC…’

OSC Setup Dialog

Local IP Address
This the IP address of your computer running MLA. If you have multiple network 
connections, you will the IP addresses for the available network ports listed in the menu.

Local Port (Incoming)
This is the port used for receiving OSC messages into MLA.

Console IP Address
This is the IP address of the console you wish to send OSC messages to.

Console Port (Outgoing)
This is the port for OSC messages transmitted out of MLA

Console Type
This is only needed if you want MLA to process OSC messages sent out of the console. 
Choose the console as appropriate (ETC EOS only work currently).

When the console type is set to ETC EOS Family, MLA can process cue triggers for the 
cue list view in the same way as the MIDI Show Control trigger for the cue list view to 
follow the console, or take automatic cue photos.
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ETC EOS Console Family Setup

ETC EOS Show Control Setup OSC Options

On the console (or Nomad), goto to Show Setup, then Show Control page. You should see 
the above options to setup OSC on the console. The above settings will work with the 
setting shown above for MLA.

OSC TX IP Address
The IP address of the computer running MLA.

OSC TX Port Number
This is the port the console will transmit the OSC messages to. The OSC TX Port Number 
(EOS) and Local Port (Incoming) (MLA) should be the same.

OSC RX Port Number
This is the port the console will receive OSC messages on from other devices. The OSC 
RX Port Number (EOS) and Console Port (Outgoing) (MLA) should be the same.

You will also need to enable String TX and String RX settings.

Once you have set the IP addresses and ports on both the console and MLA it should all 
be ready to go.

ETC EOS Command Line Viewer
You can see the EOS command Line within MLA by simply choosing ‘EOS Console…’ 
from the ‘Console’ menu. A dialog will open showing a simple view of the command line. 
Not very exciting right now. It does change from orange to blue text when you go from 
LIVE to BLIND.
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grandMA2 Communication using Telnet

An inbuilt Telnet terminal can now be used to communicate with a grandMA2 console over 
a network connection. The network connection is available within scripting to allow 
commands to be sent to the console. Macro triggers can also be received over the 
connection which will run specified scripts within MLA. Once MLA is connected to the 
console, it is not required that the terminal window is left open.

grandMA2 Telnet Terminal Window

Connect
This will attempt to connect to the grandMA2 console. If it is successful, you will see the 
welcome screen appear in the terminal window.

Disconnect
This will logout and close the connection with the console.

Login
This will log in to the console using the credentials set in the Settings dialog.

Settings
This button will open the settings dialog to allow you to configure the communication 
settings with the grandMA 2 console.
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grandMA2 Telnet Settings
The network connection is configured in this dialog.

grandMA2 Telnet Settings Dialog

Console IP Address
This is the address of the console on the network you are connected to.

Console Port
This is the port that MLA and the console will communicate over. The default of 30000 is 
the consoles default.

Local IP Address
This is the IP address of your computer. If you have multiple ethernet interfaces you 
should choose the IP address of the interface you are connected to the console with.

Login Name
If you wish to use the 'Login' button in the terminal window you should enter the user name 
on the console you wish to log in as. The default is as the "administrator".

Login Password
You should enter the password for the console user name you wish to log in as.

Confirm on Patch Collision
If the script you are running does not use the "/noconfirm" option when patching, the 
console will prompt for you to confirm or cancel the patch command if there is a patch 
collision. Enabling this option will confirm the patch command. If it is disabled, it will cancel 
the patch command. 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MLA SHOW DOCUMENT IMPORT
It is now possible to import data from another MLA show document. Individual data types 
can be import separately.

The document you are importing from must be in the same document format as the 
version of MLA you are using. You will get a message if you need to update the document 
first. The show document you have open in MLA must be saved (or an unchanged 
document since it was opened) before you can do an import.

It is only possible to import all the data of a specific type, i.e. Rig Data. When data of a 
particular type is imported, any data of the same type will be removed from the open 
document.

To import data. In an open document click on the 'Import Show...' menu item in the file 
menu. Choose the file you wish to import from. MLA will analyse the file and then present 
the import dialog.

Import Show Dialog

Only the data types available in the source document will be enabled. The Console Data 
check box will show the console data format. The data types are described below...

Rig Data
All the fixtures in the Rig Data view. It will also include an fixture profiles stored in the show 
document.

Wheel Loads
All the wheel loads. It will also include any gobos/colours that are on the wheels.
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Preset Documentation
All the Presets and Channel data in the Preset Documentation view. It will also include any 
custom sorts.

Cue List Info
All the user entered information for cues (notes & photos). This will not include the console 
cue list data, so if there is no console cue list data in the destination document then you 
will not see any data displayed.

Console Data
All the console data from the destination document.

Production Info
All the production information such as logo, designers etc.

Patch Console Fixture Profiles
All the profiles defined in the console data Patch view that allow matching to Rig Data 
when updating the view from the console patch.

Document Report Templates
All the report templates that are saved in the show document. This does not include the 
templates in the applications templates folder.

Document Preferences
All the document settings such as custom Rig Data column names, Preset priorities etc.

Once the import is complete, the document will be rebuilt and re-opened. The console data 
import log will show details of the import and if there are any errors. If an error does occur, 
it is best to go back to the saved original copy of the document as there will be incomplete 
data in the document otherwise.
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PRESET DATA VIEW
Show Preset in Preset Documentation
It you wish to look at the Preset Documentation for a Preset, right click (Ctrl click on Mac 
OS X) on the channel in the channel list for a Preset and a menu will pop up to allow you 
to view the Preset in Preset Documentation.

WHEEL LOAD VIEW
Changing Fixture Type When Copying a Load
When you copy a wheel load, it is now possible to change the fixture type of the load. Only 
the matching wheels will be copied over, i.e. colour wheel 1 to colour wheel 1, gobo wheel 
1 to gobo wheel 1 etc.

RIG DATA VIEW
Numeric Increment, Decrement and Offset
When entering numeric data into the edit field for a selection of multiple rows, it is not 
possible to have the value automatically incremented, decremented offset for each row. 
This will only work when the data is purely a number.

Increment & Offset
Using the ‘+’ character you can increment the value. If the ‘+’ character is after the number, 
i.e. ‘1+2’ will set the first selected row to 1, then increment the value by 2 for each 
subsequent row. If there is no increment value, i.e. ‘1+’ then it will increment by 1. For 
fields that support numeric values with decimal places, you can use numbers with decimal 
places, i.e. ‘1+0.1’.

If the ‘+’ character is before the number, i.e. ‘+10’, it will offset the value in the selected 
rows by the number after the ‘+’, in this case it will add 10 to the value in each row.

Example with 5 rows/fixtures selected…

Rows Before 1+ 1+2 +10
1 1 1 11
1 2 3 11
1 3 5 11
1 4 7 11
1 5 9 11

Decrement & Offset
All the same rules as incrementing and offset apply except that the ‘-‘ character is used in 
place of the ‘+’ character.

The columns that support incrementing, decrementing and offsetting are, Channel, Fixture 
Number, Unit Number, Location X, Y & Z, Repeater Port, Circuit and Multicore Way.

Sorting & Filtering
It is now possible to sort and filter by Multicore and Circuit fields.
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Rig Data Counting
It is now possible to count items in the Rig Data view. From the Utilities menu, choose the 
‘Rig Data Counting…’ menu. A dialog will open allowing you to configure what you want to 
count.

Equipment Count Window

Choose from the Count popup menu the Rig Data column you wish to count by and click 
the ‘Count’ button. The text area beneath will then be populated with the count. You can 
copy the text and paste into other applications, or save as a text file by clicking the 
‘Save…’ button at the bottom.

You can also break down the count by another column as shown below. 

24th January 2017



Equipment Count Window with a Breakdown

You can breakdown the count by another Rig Data column. In the example above, the 
fixture type count has been broken down by the case colour column.

EOS CONSOLE
• The limit of channel numbers up to 10,000 has been increased to 99,999.
• When importing palettes, you will probably see ‘Unexpected 

LEVEL_REFERENCE_TYPE’ in the import log. This is nothing to worry about. 
• Show Control Events that are cue trigger events will have their timecode value assigned 

to the relevant cue in the Cue List View. The timecode value will be found in the 
'Timecode' column.

GRAND MA2 CONSOLE
• Improved removing of invalid ASCII characters in an imported MA2 XML file.
• Added a fix for an issue where the fixture mode is not exported in an MA2 XML file.
• Improved handling of custom preset types in the Preset Data view.
• Timecode XML files are now partially processed to fix issue where it would stop 

sequence files from being imported.
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REPORTS
Universe Report
A new Universe Report has been implemented that allows you to print/pdf how the DMX 
channels in a universe are patched. Currently the report will display 64 DMX channels per 
page.

Fixture Options DIP Switch
It is now possible to include a DIP switch image of the fixture options in a Rig Data report. 
The field to include in the report template is [OptionsDIPImage].

Prepare Wheel and DIP images not longer displayed
As part of the transition to Mac OSX Cocoa framework, when generating Wheel Load or 
Rig Data reports that contain images (such a wheel image or a DIP switch image), a dialog 
will no longer appear showing the image to prepare it for placing in the report. These 
images are now prepared off screen. Look at the template CueList_EOS_CueFont.lhf for 
an example of how it can be used (their is also an CueList_MA2_CueFont.lhf template).

Cue List Report
• Added option in the dialog to choose which sequence and cues to report to ignore part 
cues. When the option is checked, only part 0 will be listed in the cue list report.
• Added Macro, Snapshot and Timecode fields.
• It is now possible to make follow and part cues have their own formatting/styling. Create 

text elements with the name FontPartCue or FontFollowCue. Apply the formatting i.e. 
Italic to the text. The elements added will not appear in a generated report.

Generic Report
There are 2 new layouts to demonstrate how a generic report can be used.

Generic_Example_Landscape - Shows preset parameter data (limited number of 
parameters).

Generic_Groups - Shows a groups sheet for the groups in the console data.

A new placeholder field [Group_Channel_List] has been added to the Generic report to get 
a formatted list of channels/fixtures in a group.

FIXTURE PROFILES
Change to Effect Wheels
Previously it was only possible to have 2 effect wheels and an animation wheel. To support 
multiple animation wheels, the effect wheels can now be up to 3 wheels which have the 
option to be an animation wheel. Existing profiles with an animation wheel will be copied to 
effect wheel 3.

Increase of DMX Modes, Front Lens, Internal Lens & Lamp options.
The number of DMX Modes, Front and Internal Lens and Lamp options has been 
increased from 10 to 20. As a result, the controls in the Fixture Profile editor have been 
changed to list boxes. To edit a field, double click on the text (or empty field) to edit.
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FIXTURE PROFILE UPDATES

GLP
• Impression X4 - Added profile.
• Impression X4S - Added profile.

Martin
• MAC 500E - Updated profile.
• MAC Viper Wash DX - Added profile.

Vari-Lite
• VL4000 Spot - Added profile.
• VL4000 Beam Wash - Added profile.
• VL3000 Spot - Updated profile.
• VL3500 Spot - Updated profile.

Clay Paky
• Mythos - Added profile.
• SuperSharpy - Added profile.
• Stormy - Added profile.
• Stormy CC - Added profile.

ETC
• Desire D40 Range - Added profiles.
• Updates and additions to ETC Source 4 Profiles & PAR.

Highend Systems
• Cyberlight v2.0 - Added profile.
• Cyberlight Turbo - Added profile.

Robe
• Robin BMFL Spot - Added profile.
• Robin BMFL Blade - Added profile.
• Robin MMX Spot - Added profile.
• Robin MMX BeamWash - Added profile.
• Robin MMX Blade - Added profile.
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v1.1.1

Version 1.1.1 includes new features and bug fixes. This release mainly addresses 
improvements with only a couple of major new features. Show documents are the same 
format as v1.1, so it will not require to be upgraded and will remain backward compatible 
with v1.1.

New Features & Improvements Include...

• Support to capture still images from video cameras/input cards.
• Improvements within the Preset Documentation view.
• New Positions report.
• Vx76 Cue List Import, 3D rotation and MIDI Show Control improvements.
• Change to the grandMA2 export macro.

VIDEO STILL IMAGE CAPTURE
It is now possible to use a video camera (such as a web cam) or video input card to 
capture still images in the Preset Documentation and Cue List views as you would with a 
tethered DSLR camera. Video cameras/input cards supported by QuickTime on Mac OSX 
and Direct Show on Windows OS should be compatible.

To use a video device, it works pretty much as you would to use a tethered DSLR camera. 
Open the Camera Setup dialog from the ‘Setup’ menu. From the ‘Camera Control’ popup 
menu, choose either ‘QuickTime’ on Mac OSX, or ‘Direct Show’ on Windows OS. The 
device list will populate with the available cameras or devices. Select the device you wish 
to use, and click the ‘Connect’ button. If the ‘Live View’ checkbox is checked, then a live 
video preview window will open and float on top of the main document window. Taking 
photos works as it would with a DSLR camera in the Preset Documentation and Cue List 
views.

When using QuickTime on Mac OSX, the ‘Video Aspect Ratio’ popup menu will be enabled 
to allow you to choose the aspect ratio of the input video. The choices are ‘Native’, ‘HD 
(16:9)’ and ‘SD (4:3)’. It is only possible to choose the aspect ratio when you are not 
connected to a video input device. The ‘Native’ aspect ratio will not always be the actual 
aspect ratio of the input device, so it is worth looking at the preview to decide if it looks 
correct.

In the bottom left of the live preview window, there is a ‘Settings’ button that allows some 
control over the image.

Note that using low cost web cams may yield poor quality images. When not using the web 
cams own proprietary software (as is the case when accessed through the computers own 
image capture framework) to control the camera, the lack of focus and exposure controls 
can not always produce good results.

RIG DATA VIEW
• It is now possible to change the fixture type for a fixture in a similar way to editing other 

cells in the Rig Data spreadsheet. When a fixtures (or range of fixtures of the same 
fixture type) ‘Fixture Type’ cells are selected, you can now choose from the popup menu 
in the ‘Edit’ area at the top left of the window ‘Change Fixture Type...’. A dialog will open 
to allow you to select the Manufacturer, Fixture Type and DMX mode that you would like 
to change the selected fixture to. Clicking the ‘OK’ button will then change the selected 
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fixtures in the Rig Data spreadsheet. Configuration items such as Lamp, Lens, Internal 
Lens, Option Bay 1 & 2 and Menu/DIP options will be set to the fixture profiles defaults.

• Added a ‘Location/Rotation’ menu item to the ‘Edit’ menu. The dialog that opens allows 
the X, Y & Z Location or Rotation to be converted, moved or rotated for all the fixtures or 
just the selected fixtures in the Rig Data view.

Location/Rotation Dialog

Units
It is possible to change the units in the Location X, Y & Z columns from one unit to another. 
Select from the drop down menus what the units currently are and what you want to 
change them to. Then select the column checkboxes you wish to change.

Move
The delta fields allow you to specify how much to move the specified coordinate. Values 
are decimal and can be positive or negative numbers.

Rotate
The delta fields allow you to rotate an axis. Values are degrees 0 to 360 and can be 
positive or negative numbers.

Location Coordinates
This area allows you to swap the location coordinates from one column to another in the 
Rig Data view. It is also possible to reverse the coordinate (i.e. makes a positive number 
negative and vice versa).

Bugs Fixed/Changed
• The <Return> key should always advance down the spreadsheet for all data columns.
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• The spreadsheet should no longer jump back to the top when you add, delete or change 
the DMX mode for fixtures.

PRESET DOCUMENTATION VIEW
• It is now possible to select multiple presets in the preset list. This allows multiple presets 

to be deleted and edited in the Preset List. It is possible to edit the ‘ID’, ‘Preset Type’, 
‘Set’, ‘Name’ and ‘Focus Cue’ for multiply selected presets.

• Select All/Deselect All now works in the Preset List.
• The ‘Order By’ button has been replaced by ‘Sort By’ and ‘Filter’ controls.
• Photo Zoom dialog now has radio buttons to choose between viewing the Preset or 

Channel photo.
• It is now possible to drag and drop pictures or picture files onto the photo area to add an 

image to a preset/channel.
• Groups can be added to Preset Documentation to aid in the documentation of the 

conventional focus. Groups will appear as a Preset Type in the Add Presets dialog. All 
the channels in the group will be added to the group in Preset Documentation.

• Adding Channels manually will now set method to get fixture type based on available 
data.

• A dialog will appear if you try to set the first used cue for presets/channels and the Main 
Show Cue List has not been defined in the applications Preferences dialog informing you 
as such.

Bugs Fixed/Changed
• The default column widths when running on Windows OS should no longer default to a 

width of zero.
• Fixed bug where preset/channel photo mode would change when adding channels even 

if it was locked.
• Fixed issue where it was not possible to copy an image from a cue on a grandMA2 

imported show document. 
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CUE LIST VIEW
• It is now possible to drag and drop pictures or picture files onto the photo area to add an 

image to a cue.
• A new cue photo zoom window has been implemented. The new window is resizable and 

is not attached to the main document window. This allows it to be dragged onto another 
monitor if desired, or zoomed to full screen. When in full screen, the menu bar and 
window title bar will be hidden (the menu bar will only be hidden if the window is on the 
screen with the menu bar). The window will track what ever the selected cue and photo 
are displayed in the Cue List View. This can be useful when tracking the cue the console 
is in for viewing the biggest possible cue photo. Overlaid on the photo is a simple HUD 
display showing details about the displayed cue. Currently the overlay is white.

HUD Display in Cue Photo Zoom Window

On the left side of the HUD is an area showing the current number and Cue List/Sequence 
of the cue photo being displayed.

In the centre area are controls to switch between the photos for the cue. The arrow buttons 
will enable to allow the switching between photos. The keyboard left and right arrows will 
do the same actions.

The area on the right has a button with a corners icon that will switch the window in and 
out of full screen mode. When in full screen mode, pressing the escape key on the 
keyboard will exit full screen mode.

The area along the bottom of the HUD will display the description assigned to the cue 
photo.

When the window is front most (or in full screen), it is possible to use the keyboard up and 
down keys to select the next and previous cue in the cue list.

If you wish to show the old Cue Photo Zoom dialog, hold down the Alt key while clicking on 
the ‘Zoom’ button.
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Bugs Fixed/Changed
• Fixed issue where it was not possible to copy an image from a cue on a grandMA2 

imported show document. 

UNIVERSE DIALOG
• Uses caching for a big speed improvement.
• A new label in the window shows the total number of DMX slots for the fixtures in the Rig 

Data view, wether patched or not.

EOS CONSOLE
• Effect data is now deleted from the show document when importing.
• Fixed import bug which could cause some errors showing intensity palettes in the 

channel data view.
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Vx76 CONSOLE
• It is now possible to send the fixtures patch and/or dimmer patch to the console. Fixtures 

with multiple DMX addresses will also be patched correctly. This only works in Vx76 
software v3.6 beta versions and v4.0.

• It is possible to send the 2D locations to a specific layout. The layouts id number has to 
be used to specify the layout. The first user layout is layout id 3.

• It is now possible to send the 3D rotation of a fixture to the Vx76. A popup menu 
determines what the values in the X, Y & Z Rotation columns are.

V676 Dialog

The changes in the dialog are as follows....

3D Rotation Values
This popup menu is used to tell MLA what the values in the Rotation X, Y & Z columns are. 
They can be...

Tilt, Rotate, Spin
This is the same as how the console shows the rotation of the fixture.
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Rotate X, Y, Z
This is the rotation value around each axis.

Down Vector
This is the vector describing the direction the fixture is pointing.

Cable Vector
This is the vector that describes the direction of the cable on the fixture.

2D Location Layout
It is possible to send the 2D coordinates to either the ‘Default 2D’ layout, or to an already 
defined layout. You specify the layout by number. The first user defined layout will be 3. 
The initial name of a layout when defined in the console will include the layout number.

Patch
It is possible to send the DMX fixture address and/or dimmer addresses to existing fixtures 
in the console patch. At present it is not possible to create fixtures from MLA on the 
console, so this must be done on the console.

GRAND MA SERIES 1 CONSOLE
• Fixed issue that would cause the application to crash when the report file from the 

console was not titled ‘report.tar.gz’.

GRAND MA SERIES 2 CONSOLE
• In the new grandMA 2 software version 2.9, the existing export macro does not export the 

patch data due to changes in the grandMA 2 software. A new macro is included. The 
previous macro for use on grandMA 2 software versions prior to v2.9 has a ‘Pre v2_9’ 
name added to it.

• Improved XML exception handling so as not crash the application.
• Added method to remove invalid characters in the XML data that is exported from the 

console.
• Import threading improved to stop some data being saved into the show document 

multiple times.

GENERAL
• Cue List CSV import will handle stacks in Vx76 imports, separating them into separate 

cue lists/sequences.
• MIDI Show Control will now handle Vx76 stack number to select the correct cue in the 

correct stack.
• Window OS version now uses GDI+.
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REPORTS
Cue List Report
• Fixed issue where the images and cue info where not taking the cue part into account.
• Issue still persists with cue lists with images over 100 pages will crash with an out of 

memory exception. When this occurs it is best to build the report using ranges of cues.

Preset Documentation Report
• Added ‘FixtureNumber’ field placeholder.
• Added ‘ChannelCue’ field placeholder.
• Fixed bug where if a Preset Documentation report was cancelled, it was not possible to 

generate another Preset Documentation report without relaunching the application.
• Fixed bug where if there was no preset data to report, the progress dialog would appear 

and not go away.

Rig Data Report
• Added ‘FixtureOptions’ field to get the fixtures non-default fixture options.
• Added ‘Separator’ element type. This can be used between fixture rows.
• Added ‘FilterField’ & ‘FilterSelection’ fields to get the filter for the displayed data.

Positions Report
• Added Positions report type to enable a report of the positions data to be generated.
Available data fields normally used in a ‘Row_’ section
PositionName
PositionNotes
NormalOutTrim
PositionWeight
NumFixtures

Data fields for additional trims normally used in a ‘RowTrim_’ section
AdditionalTrimName
AdditionalTrim

Generic Report
• Created a generic report type that allows access to any data stored in the show 

document. The Datasource in the report settings determines which database is 
accessed.
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FIXTURE PROFILE UPDATES

PRG
• Best Boy 4000 - Updated with gobos and part numbers.
• Best Boy Wash - Added basic profile. No fixture option menus.

GLP
• Impression 120RZ RGB - Added profile.

Martin
• MAC 250 Entour - Added profile and gobos.
• MAC 500E - Updated profile.
• MAC Viper Performance - Added profile and gobos.

Vari-Lite
• VL3000 Spot - Updated profile.

Clay Paky
• A.Leda B-EYE K10 - Added profile.
• A.Leda B-EYE K10 Easy - Added profile.
• A.Leda B-EYE K20 - Added profile.
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v1.1

Version 1.1 includes new features and bug fixes from previous versions. All show 
documents will be upgraded when opened in this version.

New Features include...

• Support for grandMA2 report importing.
• New Status bar at the bottom of the document window.
• Changes to tethered camera control.
• Support for embedded/nested presets/palettes (EOS & grandMA2 only).
• Application update notifications.
• New Groups & Effects views (EOS & grandMA 2 only).
• Exporting of Cue and Preset Documentation photos.

Below are full explanations of the new features and bugs fixed.

GRANDMA 2 SUPPORT
It is now possible to import the XML files that are exported from grandMA 2 console. To 
make the process of exporting from the console easier, a macro has been created that can 
be imported into your show file that will export all the information that Moving Light 
Assistant needs. See the details below on how to use this macro. The console data views 
have been updated to support the grandMA 2. In addition there are 2 new console data 
views, Groups and Effects. It is also possible to send MIDI Show Control commands over 
ethernet to trigger the cue list as is possible with the GrandMA 1.

Using the grandMA 2 Export Macro
Within the Moving Light Assistant folder, there is a "grandMA 2 Support" folder. Within this 
folder is a "GMA2" folder that should be dragged onto a USB memory stick. Once this 
done, eject the memory stick and insert the stick into the console (or the computer running 
grandMA2 onPC). To import the macro into your show file, do the following...

Steps to Import Macro
Insert the USB memory stick with the macro on into the console or the computer running 
grandMA 2 onPC.

• On the console (or onPC), press the ‘Setup’ button. 

• In the Setup window, under the ‘Console’ tab (the first tab), press the ‘Import Export’ 
button.

• Press ‘Import’.

• Press ‘Macros’.

Import Macro Dialog

The dialog shown above will appear. You will need to choose your USB memory stick from 
the tab at the top of the dialog.

• Select the ‘MLA Export.xml’ file from the ‘Select File’ list, and then select the ‘MLA Export 
All’ item from the ‘Choose Item’ list.
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• The button on the right, ‘Start at Macro’ will show the number of the macro the selected 
item will be imported as. You can click on the button to change the number, or click the 
‘Use Earliest’ button if needed.

• Finally, click the ‘Import’ button.

Exporting the Data
Once you have imported the macro into your show file, to use the macro, you a need to 
first select the USB memory stick to export to. There are two ways to do this. The first 
method is to press the 'Backup' key and then select the USB memory stick from the drive 
tabs at the top of the window. The second method is to type 'SelectDrive 4' on the 
command line. Now running the macro (either by pressing the macro in the Macro Pool, or 
typing the macro command on the command line). The macro will take a few minutes to 
complete. Once the macro has completed, remove the USB stick and insert into the 
computer running Moving Light Assistant.

Importing grandMA 2 data into Moving Light Assistant
You can either import directly from the USB memory stick, or copy the "GMA2" folder to 
the computers hard drive. You can rename the folder on the hard drive to something more 
meaningful.

• Create a new show document, or open the show document you wish to import the 
grandMA 2 data into. 

• From the "File" menu, choose "Import Console Data", "grandMA2...". The import dialog 
will open. 

• Click the "Choose" button to select the folder of the exported data. Choose the top level 
folder that contains the folders of exported data. 
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• Once you have chosen the folder, the file list (on the left) will populate with all the files 
that can be imported. Generally you want all the files, so click the "Add All" button to add 
all the files to the list on the right, which are the files to be imported. 

• Click "OK" to start the import. A progress dialog will appear while the import is done.

Modifying the Macro
There may be times you need to modify the macro. The macro will only export the first 30 
fixture types. If there are more than 30 fixture types you will need to add commands to the 
macro.
Add a line to macro...

Export FixtureType 31 "mla_fixture_Type_31"

You will need to change the fixture type and the file number, in this case to 31 
(incrementing for each line you add for each fixture type). 

You can also edit the xml file directly before you import into the console if you wish. Add 
the following text, making the same changes to the fixture type and file number...

<Macroline index="41">
<text>Export FixtureType 31 "mla_fixture_Type_31"</text>

</Macroline>

You will also need to update the <Macroline index=”41”> for all the lines after the added 
line so that they are numerically sequential and that there are no duplicates or gaps.

Another change you may need to make is to export any preset types you have created 
yourself. For example, if you have added a preset type number 11 called ‘images’, you 
may want to add...

Export Preset 11.1 Thru "mla_presets_images_11"

You can either add the line to the macro on the console, or edit the xml file as outlined for 
fixture types above.

NEW DOCUMENT WINDOW STATUS BAR
A status bar has been added to the bottom of the document window. It is split into four 
areas. On the left, status of the currently displayed view will be shown. Any status 
messages that used to be displayed for a view at the bottom of the view will now appear in 
the status bar. To the right of the view status will be the progress indicator of the loading 
tracked cue data if console data is present. In the middle of the status bar, the camera 
status is shown. More details about this are explained in the notes relating to the camera 
control changes below. The right side of the status bar, will indicate if the Rig Data view is 
in 'Click Patch' mode.

LOADING OF TRACKED CUE DATA
The loading of tracked cue data which occurs when a show document with console data is 
opened, or after a console data import, has been moved to the background. This allows 
use of several areas of the application while it is loading. Any views or data controls that 
rely on the tracked cue data will be disabled until the loading is complete. The progress of 
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the loading of the tracked data is shown in the new status bar at the bottom of the 
document window. It is fine to quit the application or close the document while the tracked 
data is being loaded.

CAMERA CONTROL CHANGES
The camera control dialog no longer needs to be kept open while capturing images from a 
tethered camera. The camera control dialog is now only used to choose and connect to a 
camera. Once this has been done, the dialog should be closed. The status of the camera 
is now shown in the new status bar. An icon will show if the camera is connected (Green = 
connected, Red = Disconnected). As images are downloaded from the camera, the file 
name will be shown in the status bar as they used to be in the floating camera control 
dialog.

The Canon drivers are now using the latest version from Canon (v2.13) which supports the 
newer DSLR models.

EOS-1D Mark III 
EOS 40D  
EOS-1Ds Mark III 
EOS DIGITAL REBEL Xsi/450D/ Kiss X2
EOS DIGITAL REBEL XS/ 1000D/ KISS F
EOS 50D
EOS 5D Mark II 
EOS Kiss X3/EOS REBEL T1i /EOS 500D 
EOS 7D  
EOS-1D Mark IV 
EOS Kiss X4/EOS REBEL T2i /EOS 550D 
EOS 60D  
EOS Kiss X5/EOS REBEL T3i /EOS 600D 
EOS Kiss X50/EOS REBEL T3 /EOS 1100D
EOS 5D Mark III 
EOS 1D X 
EOS Kiss X6i/EOS 650D/EOS REBEL T4i 
EOS 6D  
EOS-1D C
EOS Kiss X7i/EOS 700D/EOS REBEL T5i
EOS Kiss X7/EOS 100D/EOS REBEL SL1

This version should also fix issues seen when running on Mac OSX 10.8 and Windows 8.

If you change from one camera connection type, i.e. Image Capture to another connection 
type, you will need to relaunch the application. The newer Canon drivers do not like being 
loaded while Image Capture is active. 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CHECK FOR UPDATES
When the application launches and is connected to the Internet, it will check that it is the 
latest version. It is also possible to manually check if the application is the latest version by 
choosing 'Check for Updates' from the help menu. If the current version is not the latest, a 
dialog will appear to inform you a newer version is available and one of the dialog buttons 
will take you directly to the Moving Light Assistant download page in your web browser. 
You may then select the download for the operating system you are running from the 
download web page. Note that only release versions will be notified in this way.

NEW GROUP DATA VIEW
When importing EOS or grandMA 2 files, the group data will now be imported. A new 
Console Data view is available to view the group data.

NEW EFFECT DATA VIEW
A new view has been added to the Console Data tab which allows you to view effect data 
for EOS and grandMA2. EOS effect data will only show the effect numbers, names and 
where is is used. GrandMA2 data will additionally show the actual effect data and settings. 
Currently the EOS does not export the effect data and settings, so that data is not 
available.

Effect Data View

This view enables you to see the stored effects (Effect pool on grandMA2), where it used 
in the show and for grandMA2, the effect settings and channels if they are stored in the 
effect directly. Initially when the view is opened, the ‘Show Effect Usage in Cue Column’ 
checkbox will be off (and may be disabled while tracked cue data is loading).  Check this 
check box to see if the effect is used in cues. Selecting an effect will display which cues 
use the effect in the ‘Effect Usage’ section of the view. For the grandMA2, when an effect 
is selected, the ‘Effect Data’ section will be populated. Clicking on an effect line, will show 
any channels and their settings if channels are stored directly in an effect pool effect. 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EXPORT OF CUE & PRESET DOCUMENTATION PHOTOS
It is now possible to export any photos stored in the show document using the new menu 
command File -> Export -> Photos...

A Dialog will open to allow you to choose the images to export. Select the radio button for 
the images you want to export, either ‘Cue Photos’ or ‘Preset Photos’. If you have chosen 
cue photos, you will need to select the Sequence/Cue List. The table will populate with all 
the images in the show document. Click the checkboxes of the images you wish to export 
(to export all the images, click in the table, select all via the edit menu or keyboard shortcut 
and then click on a checkbox). If you wish to include any image adjustments or drawings 
on the images, check the ‘Include Drawings’ checkbox. Click the ‘Export’ button and you 
will be prompted for a folder to save the images into.

The images will be named by the cue or preset it is from. The images will be saved as a 
jpeg image. The quality of the image will be the best it can be from the stored image. 
Remember that the size of the image may be smaller than the original photo dependent on 
the photo import settings when originally capturing or adding the image.

Export Photos Dialog

CLEAN UP SHOW DOCUMENT
The ‘Clean Up Show Document...’ menu command will now also remove any unreferenced 
fixture profiles or gobos/colours from the document. This is useful when you have custom 
gobos that are no longer used for instance, keep getting added back into the gobo library 
every time you open the show document.
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APPLICATION
Menu Changes
• New menu File -> Import Console Data -> grandMA2
• Changed menu File -> Import Console Data -> grandMA Series 1
• Changed menu File -> Import -> Lightwright 5... to Lightwright Text File...
• New menu File -> Export -> Photos...

Bugs Fixed/Changes
• Fixed issue where MIDI did not work on Windows OS.
• Fixed crash that would occur if you double click a document to open the application for 

the first time.
• Changed dialog that appears if the document being opened was created in a newer 

application version. It is now possible to cancel the opening of the document.

RIG DATA VIEW
Cursor Keys
Using the cursor keys to change the selected cell in the rig data table has been improved. 
When the 'Edit' text field has not been clicked or typed in, the left and right keys will move 
the selection a cell left or right.

Bugs Fixed/Changes
• Fixed bug with Update Rig Data from Console Patch on grandMA 1 when comparing 

DMX addresses.
• Fixed bug where you could not exit click patch until after first click.

WHEEL LOAD VIEW
• When adding a new gobo to the library, the Catalog list will now show all the Catalogs 

currently in the library.
• Added checks to stop crashes where there are no positions on a wheel. Likely causes 

include incorrect number of positions set in the fixture profile verses the positions in a 
default wheel load.

PRESET DOCUMENTATION VIEW
• Fixed bug where padlock would grey out unexpectedly.
• It is now possible to choose ‘tga’ files when adding images to a preset/channel.

PRESET DOCUMENTATION - FIXTURE VIEW
• Relayed out the user interface for a bigger resizable photo.
• Added a ‘Zoom’ button to open the photo at a larger size (the same as the Zoom button 

in the Preset Documentation and Cue List views).

PHOTO EDIT DIALOG (Preset Documentation/Cue List)
• When the photo has been clicked (to get focus), the keyboard shortcuts for Copy, Paste, 

Select All and Deselect All should work.
• Deselect All menu item should now enable correctly.
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CUE LIST VIEW
• Apostrophe characters are now handled correctly in sequence names.
• It is now possible to choose ‘tga’ files when adding images to a cue.
• If a console type is not set by a console data import, the cue time for auto photo 

triggering will be determined by the ‘Duration’ field, or the combination of the ‘FadeTime’ 
& ‘OutFadeTime’ fields. Useful when the import ‘Cue List CSV...’ menu command has 
been used to import a cue list.

• When using MSC over ethernet from the grandMA 2, the back, and jump forward/back 
commands do not appear to work due to grandMA2 MSC issues.

CONSOLE DATA - CUE DATA VIEW
• Apostrophe characters are now handled correctly in sequence names.
• Added ‘Fixture’ & ‘Part’ columns for grandMA 2.

CONSOLE DATA - CHANNEL DATA VIEW
• Apostrophe characters are now handled correctly in sequence names.
• Added a checkbox to show grandMA 2 effects in parameters.
• Added a checkbox to highlight grandMA 2 effects in parameters.

CONSOLE DATA - PRESETS VIEW
• Added support for grandMA 2.
• All Channels are now added to channel list on the left side of the screen due to support 

for Global and Universal preset types on grandMA 2.
• Presets on grandMA 2 use the preset id instead of the presets name to more accurate 

preset use searching.
• Nested/Embedded presets/palettes are now supported for grandMA 2 and EOS. When 

displaying parameters for a preset, nested/embedded parameters will be highlighted in 
blue.

• Checking for preset/palette use will now handle nested/embedded presets/palettes.
• Checking for preset use will now handle presets used in effects (grandMA2 only).
• Preset Use table at the bottom of the window is now split into Cues, Effects and Presets. 

Using the radio buttons above the table, you can choose to see the preset use in those 
data types (EOS & grandMA2 only).

CONSOLE DATA - PATCH VIEW
• Added support for grandMA 2.

CHANNEL USAGE VIEW
• Act and Scene number selection will only list cues that exist in the cue list now.
• Channel table now gets focus so the up/down keys will now work correctly.
• Fixed bug where EOS Focus Palettes were not reported correctly.
• MA2 will now list presets with embedded presets and also presets used in effects.
• EOS will now list nested palettes/presets.

MANAGE UNIVERSES DIALOG
• Fixed bug where an address of 0 would crash application.

MANAGE FIXTURE TYPES DIALOG
• Fixed issue where certain characters in a fixture types name would not allow the fixture 
type to be found and changed in the Rig Data view.
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EOS IMPORT
• Import checks targets are loaded before loading levels. Stops NilObjectException if 

targets are not in file.
• Modified Read routines to skip empty lines that may appear if there are odd line endings, 

like CR, CR, LF instead of a LF.
• Cue Lists should now be ordered numerically.

GRANDMA 1 IMPORT
• Sequences should now be listed numerically (Only on documents imported in this 

version).
• Clean up of import threading.GRANDMA 2 MIDI SHOW CONTROL
MIDI Show Control from the grandMA2 will trigger the MLA Cue List view as with GrandMA 
1 & EOS consoles. A USB MIDI interface can be used as well as sending the commands 
over ethernet (as with the GrandMA 1). Some MSC commands do not currently work 
correctly as the grandMA2 appears to not send correctly formatted MSC commands. The 
Go and Pause commands work fine, though the jump forward/back and resume 
commands do not work.

Below is a screen shot of the MIDI Show Control setup page as a starting point for setting 
up the MSC. You may need to adjust the settings depending on your setup.

Midi Show Control Setup Dialog

REPORTS
Rig Data
• ‘Weight’ field is now implemented to get fixtures weight. Units are set by the applications 

units preference.

Wheel Load
• Fixed issue where a wheel would draw off the bottom of the page.
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Preset Documentation
• Fixed bug where a crash would sometimes occur when copying the folder of PDF pages 

generated.

Cue List
• Added option in Cue List Report setup dialog to specify a cue range for the report. 

Leaving the cue fields blank will report all cues in the cue list. Due to a bug where cue 
lists with hundreds of cue photo may cause the application to crash, it can now be broken 
down into smaller chunks of cues using cue ranges.

• New grandMA 2 specific report template has been added.

FIXTURE PROFILE UPDATES
Martin
• Added MAC III AirFX.
• Added MAC III Wash.

Vari-Lite
• Updated VL3500 Wash FX to include wheel images.

Green Hippo
• Added Hippotizer profiles (v3.14 & v3.20).

Clay Paky
• Added Sharpy Wash 330.
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v1.0.2

MIDI Show Control Improvements
The MIDI Show Control processing has been improved. 
Fixed issue when using some USB MIDI interfaces that would cause MSC messages to 
get messed up causing incorrect behavior. 
MSC commands Pause and Resume are now supported. Timed Go is supported, but will 
not trigger an auto cue photograph if the feature is enabled. The GrandMA 1 console uses 
a Timed Go command when bumping backwards and forwards through cues, so now the 
cue list will follow the console more accurately.

MIDI Show Control over Ethernet for GrandMA 1
It is now possible to chose to receive MSC messages over ethernet for the GrandMA 1 
console. Chose the ‘Ethernet GrandMA’ option from the choice of MIDI Ports in the MSC 
Setup dialog. A ‘Port’ text field will appear. The port must match the port set on the console 
(The default 6004 is the same as the default on the console). You will need to enable 
‘Ethernet’ for the MSC Output on the console too. You can connect to a network (wired or 
wireless) that the console is on. You will need to configure your network settings so you 
are connected to the network (IP Address and Sub-Net Mask).

Preset Documentation - Photo Mode Lock
It is now possible to lock the photo mode to Preset or Channel by clicking on the padlock 
below the Channel radio button. This is useful when taking channel photos so that it does 
not switch back to Preset when you select another channel. When you select a another 
preset, the padlock will automatically unlock.

Preset Documentation -  Photo Copy Changed
The ‘Copy’ button is now longer a menu and will now open a new copy photo dialog. In the 
dialog, you can now copy photos from Presets, Channels and Cues to the current Preset 
or selected Channels within the selected Preset. There are options of what to copy 
including a preview of the photograph you are going to copy.

Preset Documentation - Space bar will take a Photo
If Camera Control is being used in the Cue List view, the Space bar will take a photo. This 
will only work if a text field does not have focus (as it will add a space in the text field).

Fixture Profile Edit - Re-Order Fixture Menu/DIP Options
It is now possible to drag re-order the fixtures menu/DIP options.
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Fixture Profile Edit - Copy Menu/DIP Options from another Profile
There is now a button when editing fixture profiles to copy the Menu/DIP options from 
another fixture profile. It will replace all the current options with the options from the copied 
profile.

Cue List - Photo Copy Added
A photo ‘Copy’ button is now available and will now open a new copy photo dialog. In the 
dialog, you can copy photos from Presets and Cues to the current cue. There are options 
of what to copy including a preview of the photograph you are going to copy.

Cue List - Space bar will take a Photo
If Camera Control is being used in the Cue List view, the Space bar will take a photo. This 
will only work if a text field does not have focus (as it will add a space in the text field).

Cue View - Cue Progress Bar
A progress bar has been added to the Cue View that will show the cues progress as it 
does in the Cue List view.

Channel Usage - Improvements
The Channel Usage view has had a major code re-write. Errors in tracking would report 
some channels as unused when in fact they were. There are also some enhancements...

Channel Usage - GrandMA - All Preset Type listed
For GrandMA consoles, the ‘All’ preset type use is now counted and also available in the 
list of presets on the right of the window.

Channel Usage - EOS - Presets, Focus, Colour and Beam listed.
For EOS consoles, the Preset, Focus Palettes, Colour Palettes and Beam Palettes are 
now listed. The captions on the tab panel now reflect the preset/palette names.

Channel Usage - List Used & List Unused Radio Button
Previously there were 2 disabled checkboxes at the bottom of the Preset/Palette List. 
These have been changed to Radio Buttons and are now enabled and will change the list 
of presets to show presets/palettes used in cue lists, or show the presets and palettes no 
used in the show (presets/palettes only used in the rig check will be listed in the Unused 
list).

Channel Usage - Preset List Enhancements
The Preset/Palette list will now show presets/palettes that are used in cue lists but have no 
intensity greyed out. Presets/Palettes with intensity can now be expanded to show a list of 
cues that the channel has an intensity above zero while in the preset/palette.

Channel Usage - ‘Clear’ filter button added
A ‘Clear’ button has been added which will reset the Channel Usage filter options back to 
the default (All cue lists with no cue or channel ranges).

Channel Usage - Act & Scenes Range Popup Menus
It is now possible to select a range of Acts or Scenes.
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Cue List CSV Import
This is a beta feature which I have left in the release version. Under the ‘File->Import 
Console Data’ menu, there is a menu ‘Cue List CSV...’. This feature allows you to import a 
cue list as a delimited text file. This allows you to add your own cue lists generated in a 
spreadsheet application or by importing exports from currently unsupported consoles. 
Some consoles such as the PRG Vx76 console can export the cue list as a tab delimited 
file. This feature will allow you to import the file to create a cue list to use for 
documentation. It basically works, but does need some refinement, which will happen over 
the next releases.

Beta Version Logo
Beta software versions will now display ‘BETA’ in red text on the logo in the Splash and 
About dialog.

Report - Cue Moves
The Cue Moves report has been modified so that a cue will not normally be split across 
pages. The only exception is when a single cue has so many channels it will not fit on one 
page by itself. When a single cue is more than one page, the appropriate cue header and 
channel type header (Up, Down or Track) will be added to the page the cue is split over.

Report - Channel Usage
Added field [UsageScene] to access the selected scene range for a report.
A Report will only be generated if the current filter setting in Channel Usage have been 
processed.

Bugs/Issues Fixed
• Cue List View - Fixed issue where changing more than one cue information text field 

would result in not all the fields being saved.
• Fixed issue where it was not possible to ampersand characters (‘&’) in fixture profile 

manufacturer names.
• Fixed issue where it was not possible to ampersand characters (‘&’) in Preset 

Documentation and Cue List photo captions.
• Fixed issue of application becoming unstable if the application was minimised when it 

was last quit. 
• Update From Rig Data should now handle EOS absolute addresses and address ranges 

correctly.
• Rig Data - The Filtered combo box will now refresh correctly when the document 

preferences for the universe display format are changed.
• Camera Capture preview window will now accept Return & Escape keys as default 

button key actions.
• Changed location of the show document temporary file to Application Data folder. (Mac 

OSX - user:Library:Application Support, Windows 7 - \user\AppData\Roaming\)
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Fixture Profile Updates
Martin
• MAC 550 Profile - Added.
• MAC 700 Spot - Changed Colour and Animation size text.
• MAC 700 Wash - Changed Colour size text.
• Glaciator X-Stream - Added.
• MAC 301 Wash - Added.

Clay Paky
• Alpha Profile 700 - Updated (v1.6)
• Alpha Profile 1200 - Added (v1.3)
• Alpha Spot 575 - Updated (v1.3)
• Alpha Spot QWO 800 - Added (v1.1)
• Alpha Wash 700 - Updated (v1.3)
• Alpha Spot HPE 300 - Added (v1.3)
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v1.0.1

Windows OS Licensing
The machine ID is generated differently due a bug that appeared where the machine id 
would change by itself preventing registration and the application recognising the 
computer it was running on. This would only happen on some Windows OS setups. Some 
Windows OS users may need to re-register their computer to use the new machine id.

Import/Export Rig Data
The ‘Gate Gobo’ field is now available in the Rig Data import and export dialogs. Newly 
added channels will also now have their ‘Gate Gobo’ field set correctly if it is being 
imported.

Rig Data - Update From Patch
If the imported console data is from an EOS console, absolute DMX addresses are now 
handled when updating the Rig Data from the console patch.

Reports - Rig Data
The ‘DMXSystem’ field will now display the name of the system rather than it’s 
identification number.

Reports - Preset Documentation
Added to report the Focus Cue for each channel.

Canon Camera Control
When using automatic photo taking, if there is an error in the camera (i.e. it is busy or the 
focus failed), a dialog will no longer popup with the error. Errors will fail silently. This would 
cause a problem that the application would stop taking photos until the dialog was 
acknowledged.

Preset Documentation - Set A Presets Focus Cue/Set
A new command has been added to the ‘Set First Used Cue’ toolbar button. The ‘For All 
Presets (Not Channels)’ will set the Focus Cue (and lookup the Set from the cue list) for a 
Preset where all the channels use the preset for the first time in the same cue. It will NOT 
set the channels Focus Cue, and does not actually need the channels to have their Focus 
Cues set first, though generally you might want to do this using the appropriate command. 

There are 2 options in the dialog that will popup to confirm the command. By default, the 
command will set all Presets regardless of the previous Focus Cue or Set entries. You can 
use the options to determine if it should not change the Focus Cue or Set if they already 
have entries in them.
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Bugs/Issues Fixed
• Manage Positions dialog will now be closed before the command error dialog appears if 

there are command errors.
• Rig Data command errors will no longer be reported if a channel was not visible when a 

command was modifying a channel that is filtered. This would commonly be seen if you 
were changing position names in the Manage Positions and the Rig Data view was 
filtered.

• Rig Data filter by Position will now update the list of positions if changed in Manage 
Positions without the need to change the filter to something else and return to Position.

• Wheel Loads animation wheel is now drawn correctly if the wheel image section of the 
window is resized. Also the highlighting of the wheel when dragging a gobo to the wheel 
image will highlight correctly.

• Profile Edit DMX Parameter list bugs fixed where incorrect DMX mode would sometimes 
be displayed.

• Rig Data, it is now possible to edit the cells in the ‘Frost’ column.
• Preset Documentation - When deleting photos, the dialog should now correctly state if 

you are deleting a Preset or Channel photo.
• GrandMA Import - The .tar.gz decompression is now much faster then in v1.0.
• Application - Fixed Nil Object Exception when recovering a show document after a crash.

Fixture Profile Updates
Vari-Lite
• VL5B - Corrected DMX Parameter names.
• VL5Arc - Corrected DMX Parameter names, No longer external dimmer.
• VL6 - Correct DMX Parameter names. Added lens choices.
• VL6C - Corrected DMX Parameter names.
• VL2000 Spot - Corrected DMX Parameter names.
• VL2000 Wash - Corrected DMX Parameter names.
• VLM - Added.
• VLX - Updated menu options and DMX parameters.
• VLX3 - Added.
• VL3015 - Added.

Martin
• MAC Viper Profile - Complete profile added with wheels and gobos/colours/effects.
• MAC 2000 Wash - Added menu options.
• MAC 2000 Profile - Added menu options, added UV Transmitter part number.
• MAC III Profile - Completed profile with wheels and gobos/colours/effects.
• MAC III Performance - Added complete profile.

Catalyst
• Added set of profiles for the Catalyst Media Server (Thanks to Erik-Jan Berendsen).

Color Kinetics
• ColorBlaze 48 - Updated DMX Parameters, lenses and weight.
• ColorBlaze 72 - Updated DMX Parameters, lenses and weight.

James Thomas Engineering
• PixelLine 1044 - Spelling correction and Updated DMX Parameters.
• PixelLine 110 - Spelling correction.
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